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Warranty, liability and support 

We do not accept any liability for the information contained in this 
document. 

Any claims against us - based on whatever legal reason - resulting from the 
use of the examples, information, programs, engineering and performance 
data etc., described in this document shall be excluded. Such an exclusion 
shall not apply in the case of mandatory liability, e.g. under the German 
Product Liability Act (“Produkthaftungsgesetz”), in case of intent, gross 
negligence, or injury of life, body or health, guarantee for the quality of a 
product, fraudulent concealment of a deficiency or breach of a condition 
which goes to the root of the contract (“wesentliche Vertragspflichten”). The 
damages for a breach of a substantial contractual obligation are, however, 
limited to the foreseeable damage, typical for the type of contract, except in 
the event of intent or gross negligence or injury to life, body or health. The 
above provisions do not imply a change of the burden of proof to your 
detriment. 

The Application Examples are not binding and do not claim to be complete 
regarding the circuits shown, equipping and any eventuality. They do not 
represent customer-specific solutions. They are only intended to provide 
support for typical applications. You are responsible for ensuring that the 
described products are used correctly. These Application Examples do not 
relieve you of the responsibility of safely and professionally using, installing, 
operating and servicing equipment. By using this application example you 
accept that Siemens is not liable for any damages except for those 
specified in the above liability clause. We reserve the right to make 
changes to these application examples at any time without prior notice. If 
there are any deviations between the recommendations provided in these 
application examples and other Siemens publications - e.g. Catalogs - then 
the contents of the other documents have priority. 

 

Copyright© 2009 Siemens I IA. It is not permissible to transfer or copy 
these Application Examples or excerpts of them without first having 
prior authorization from Siemens I IA in writing. 
 

If you have any questions concerning this document please e-mail us to the 
following address: 

 

mailto:online-support.automation@siemens.com 

mailto:online-support.automation@siemens.com�
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Preface 

Purpose of this document 
Typical PCS 7 systems have at least one ES (Engineering Station) on the 
PC side, one or more possibly redundant servers, as well as several OS 
clients (Operator Stations). Apart from the maximum availability of process 
control and data acquisition, the predominant option here is loading 
program changes or expansions quickly into the running process with out 
any interference. 

In comparison, small systems or stand alone units tend to work with 
extremely little maintenance requirements after commissioning. To 
reaching a high efficiency requires being able to work with as few PC 
stations as possible. It therefore makes sense to use the rarely used ES as 
an OS in process mode, as it already contains all the necessary 
functionality and licenses. 

This document is meant as a selection aid during research for the suitable 
PC configuration for small plants. Various minimal configurations (up to a 
maximum of three PCs) are compared regarding their functionality. Since 
the respective PCS 7 configuration is not a focus of the system 
documentation, the activities necessary for the setup are given in form of 
detailed step-by-step instructions. 

Main contents 
The main focus is on the following points: 

• Configuration comparison regarding functionalitiy 

• Activities for engineering of the various configurations 

Reference to the Automation and Drives Service & Support 
This article is from the Internet application portal of the Industry Automation 
and Drive Technologies Service & Support. The following link will take you 
directly to the download page of this document: 

http://support.automation.siemens.com/WW/view/en/24023824 

 

 

http://support.automation.siemens.com/WW/view/en/24023824�
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1 Minimal Configurations - An Overview 

Based upon using the Engineering Station as an Operator Station in 
process mode, or realizing several OS with as few PCs as possible, various 
constellations are possible. The following variants were selected according 
to feasibility and sensibility within the context of PCS 7. 

In connection with the configurations shown here, possible solutions are 
described, where the configurations do not differ considerably. 

Generally, when using the engineering computer as OS, certain 
functionality losses must be taken into account, as for certain activities the 
OS project must be closed. This will also be discussed below in more 
detail. 

1.1 ES/OS Stand-alone Systems 

The smallest of all possible configurations requires only one PC station. 
Figure 1-1 

 

Process mode / functionality 
Since version 6.1 of PCS 7, the OS project can also be compiled while 
Runtime is activated (delta compilation). This provides the operator function 
and archiving functions permanently. 

 

NOTE The description and configuration instruction for this configuration is 
available in chapter 3 ES/OS Stand-alone Systems. 

 

Alternatives / variations 
Alternatively, the complete SIMATIC PCS 7 BOX package is also an option. 
It combines the AS, the OS and the ES in a compact PC system. A 
PROFIBUS interface for connecting the decentralized process periphery is 
also integrated. 

 

NOTE The stand-alone system ES/OS can also be expanded by the PCS 7 OS 
Web Server functionality. The respective instruction can be found in 
chapter 7 "Expansion by PCS 7 Web Option" 
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1.2 ES/OS Client and OS Server 

With an additional PC station as the OS server, there is the option of using 
the ES as the OS client. It accesses the data of the OS server in process 
mode and visualizes the data. 

Figure 1-2 

 

Process mode / functionality 
For PCS 7, the OS server can be used for operator functions if a maximum 
of four OS clients are connected. During server failure, however, the 
complete OS functionality fails in this example. Furthermore, the OS client 
must be closed for later OS project changes. However, the OS server 
continues working during compiling/loading of changes. 

 

Note The description and configuration instruction for this configuration is 
available in chapter 4 “ES/OS Client and OS Server”. 

 

Alternatives / variations 
Another advantage of this configuration is the option of connecting further 
clients to the OS server in a relative simple and cost-effective way. 
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1.3 ES/OS-Master and OS-Standby 

As a further constellation option with two PC stations, the ES is used as OS 
stand-alone station again, similar to the first variant, with only one PC. 
However, it uses the same OS project, which was previously loaded to a 
further OS stand-alone station. Before the OS project is activated on both 
stations, the mutual redundancy parameterization is performed. 

 
Figure 1-3 

Terminal bus

OS-Standby 

COM-Cabel

Redundancy

ES / OS-Master

 

Process mode / functionality 
In this example, both PC stations work as redundant stand-alone OS 
stations in process mode, which mutually synchronize each other during 
operation as well as after failure of one of the partners. This also becomes 
relevant during later OS project changes for which the master OS needs to 
be terminated. In this case, the standby OS takes on the master role. It 
continues working during compiling/downloading of the changes and 
updates the redundancy partner after its return. 

The COM-Cabel (RS 232 Connection) is used for optimization of internal 
communication between both OS Single Stations. 

From PCS 7 V7.0 it is also possible to implement the redundancy 
connection via an Industrial Ethernet connection (BCE or CP1613) instead 
of the COM connection. 

For a complete download, the OS project must be deactivated and closed 
on both stations. During this time, no OS functionalities are available. 

Note This architecture does not provide the full PCS 7 functionality because 
the redundancy is setup based on WinCC tools. 

The respective restrictions during process operation and differences in 
system behavior can be found together with description and configuration 
instruction in chapter 5 "ES/OS-Master and OS-Standby". 
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Alternatives / variations 
As an alternative, the redundancy could be omitted here. Regarding costs, 
however, you only cut down on the redundancy license. Furthermore, it 
must be noted, that during process mode, the parallel usage of the OS 
project of another station is not PCS 7 conform. 

 

Note The stand-alone system ES/OS can also be expanded by the PCS 7 OS 
Web Server functionality. The respective instruction can be found in 
chapter 7 "Expansion by PCS 7 Web Option". 
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1.4 ES, OS-Master and OS- Standby 

The PCS 7-conform realization of the OS redundancy requires three PC 
stations. The ES then only fulfills engineering tasks and is only used for 
testing OS functions during that time. 

Figure 1-4 

 

Process mode / functionality 
Since the ES is not involved in the process mode, the operator functions of 
both OS stand-alone stations are permanently available. Even during a 
complete download of project changes, one OS always remains active. The 
redundancy provides for mutual synchronization. Online as well as after 
failure of one of the partners. 

The COM-Cabel (RS 232 Connection) is used for optimization of internal 
communication between both OS Single Stations. 

From PCS 7 V7.0 it is also possible to implement the redundancy 
connection via an Industrial Ethernet connection (BCE or CP1613) instead 
of the COM connection. 

 

Note The description and configuration instruction for this configuration is 
available in chapter 6 “ES, OS-Master and OS-Standby”. 

 
 

Alternatives / variations 
The low-maintenance systems focused on in this documentation often do 
not require a permanent ES. If a temporary ES is hired for configuration, 
commissioning and project changes. 

The theoretical expansion with additional OS clients is not possible without 
problems in this example, as the two OS have not been installed server 
operating systems. 
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2 General/Optional System Settings 

The relevant cross-configuration system settings are suggested below. 

2.1 Bus Connection of the PC Stations 

Plantbus (system bus) 
In the ES as well as in each server, a network card in “Configured Mode” is 
employed for the plantbus. On this network card, only the ISO protocol is 
activated for Windows. If a CP 1613 exists, it is used as access to the 
plantbus. The configuration occurs in SIMATIC NetPro and HW Config. 

Terminal bus 
Apart from the configuration with only one ES/OS single station, all other 
PC stations are also linked with the terminal bus. The required second 
network card of ES and the server is set to “PG operation”. In 
SIMATIC NetPro and HW Config this card is not configured. PCS 7 finds 
this network access via the computer names or the paths for the target 
computer, which must be entered at the Object Properties of the PC 
station. For this network card, only the TCP/IP protocol (no ISO) is 
activated for Windows. 

Client-PC stations are generally only equipped with a network card that 
connects them to the terminal bus. For this network card, only the TCP/IP 
protocol (no ISO) is activated for Windows. 

2.2 WinCC Autostart 

This document contains the step-by-step instructions, that the OS project in 
the WinCC Explorer is opened on the OS servers and clients for the 
purpose of activating Runtime. 

In the system this should be avoided, as normally no configuration licenses 
(RC licenses) exist on the OS. If the WinCC Explorer is hereby opened for 
more than an hour, WinCC goes into demo mode and must be closed 
entirely for further configuration steps (incl. Runtime) and be opened again. 

In order to activate Runtime automatically with the computer start-up 
without opening the WinCC Explorer, an autostart for the project can be 
configured. 

In conjunction with SIMATIC NET Edition 2005 (as from WinCC V6.0 SP3) 
the WinCC tool "AutoStartRT" should be configured in "Set SIMATIC 
NET Configuration Console PC station" in order to configure the 
WinCC Autostart: 

http://support.automation.siemens.com/WW/view/en/23061262 

http://support.automation.siemens.com/WW/view/en/23061262�
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3 ES/OS Stand-alone Systems 

3.1 Configuration Description 

The stand-alone system is the smallest possible configuration. The same 
PC is used for ES and OS functionalities. 

Hardware configuration 
Figure 3-1 

 

PCS 7 configuration 
Figure 3-2 
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3.2 Required Hardware and Software Licenses 

Hardware 
The following hardware is recommended for this configuration and can be 
ordered via the Siemens mall. Your selected operating system and the 
system software SIMATIC PCS 7 are then preinstalled accordingly. 

Table 3-1 

Component Product information Operating system Plantbus transition 

SIMATIC PCS 7 ES/OS 
IL 547B BCE WXP 

Windows XP SP3 RJ45 
network card 

1 x ES 

SIMATIC PCS 7 ES/OS 
IL 547B IE WXP 

Windows XP SP3 CP1613 A2 

 

Software licenses 
In the following please find the software/license package necessary for this 
configuration selection. 

In the selected configuration as a stand-alone system, the number of the 
POs is restricted to no more than 2000. 

Table 3-2 

Software Name 

1 x Engineering Software for combined 
stations 

SIMATIC PCS 7 Engineering Software V7.1 
AS/OS Runtime license 

• 250 PO 
• 1000 PO 
• 2000 PO 

 

Note The “Rental License”, which is restricted to 30 operating days or 50 
hours, provides additional licenses for engineering of short-term projects. 
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3.3 Step-by-step Configuration 

Note The following instruction was generated on the basis of Windows XP SP3 
and PCS 7 V7.1. 

For the plantbus transition a CP1613 is used as an example. 

 

3.3.1 ES Configuration 

Generating the multiproject 
As a basis for the following instruction, all PC stations must be physically 
networked according to Figure 4-1 (S.12). Furthermore, a multiproject must 
have been created on the ES in which the AS has already been configured 
regarding hardware and software. 

Generating a PC station 
In the PCS 7 project, the PC station is generated, which represents the ES 
as well as the OS. 

Table 3-3 

Step Activity Screenshot 
1.  In the “Component view”, open the 

context menu of the project and 
insert a new PC station via 
“Insert New Object > 
SIMATIC PC Station”. 
Change the name of the PC station 
so that it corresponds to the name 
of the local computer in the 
network. 
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Step Activity Screenshot 
2.  Open the HW Config of the PC 

station of the OS server. 

 
3.  From the object catalog (“View > 

Catalog”), add a “WinCC Application” 
and a network card of the type 
“CP1613”. 

 
4.  Under “Subnet”, select the plantbus 

or create it with the button “New…” 
Assign the respective MAC 
address to the CP 1613. 
Deactivate the option “IP protocol 
is being used”. 
Confirm the settings with “OK”. 

 
5.  Save and compile via menu item 

“Station > Save and 
Compile”. 
Close the HW Config. 

 

 



 
ES/OS Stand-alone Systems

Minimal Configurations PCS 7 V7.1 24023824
 

Version 3.3 13.09.2011 16/118
 

C
op

yr
ig

ht
 ©

 S
ie

m
en

s 
A

G
 2

01
1 

A
ll 

rig
ht

s 
re

se
rv

ed
 

Configuring the PC station 
The function “Configure PC station” transfers the project configuration to 
one or more target stations. 

Table 3-4 

Step Activity Screenshot 
1.  Configure the component 

configurator of the ES. Select the 
PC station of the ES and choose 
“PLC > Configure…” from the 
context menu. 

2.  Under “Accessible computers”, choose 
choose the PC which is provided 
for configuration. 
 
NOTE 
If you chose the option “Computer 
name identical to the PC station name” in 
the component view “Object 
Properties” for the PC station, the 
component configurator directly 
displays the target computer to be 
configured. 
 
With “Display”, you can have the 
current configuration of the PC 
station displayed. 
Hit the “Configure…” button. 
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Step Activity Screenshot 
3.  In the displayed window you see 

how the PC station is configured. 
Confirm this with “OK”. 

 
4.  Acknowledge the information with 

“OK”. 
 

5.  Finally, you receive the following 
message in the bottom window: 
“Transfer completed successfully.” 
Close the configuration dialog box. 

 

Configuration and download of the AS/OS communication 
The connection with NetPro is configured below and loaded into the 
stations. 
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Note For station granular configuration, the subnets of the individual 
subprojects must be joined beforehand. 

 
 

Table 3-5 

Step Activity Screenshot 
1.  Open NetPro. 

Select the WinCC application of 
the ES and open the context 
menu. Choose “Insert New 
Connection”. 

 
2.  In the “Connection Partner” 

window, select CPU of the AS. 
Make sure that in the “Connection” 
field, “S7 connection” has been 
selected. 
Confirm the setting with “OK”. 
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Step Activity Screenshot 
3.  In the “General” tab, in 

“Connection identification”, change 
the “Local ID” into a meaningful 
name, like AS25. 
Confirm the entry with “OK”. 

 
4.  Save and compile “Network” > 

“Save and Compile…”. 
Select “Compile and check 
everything”. 
Confirm the setting with “OK”. 

 
5.  Mark the ES and then, over the 

menu item load “PLC > 
Download to Current 
Project > Selected 
Stations”. 
Download the AS in the same way. 
Then close NetPro. 

 
 

Compile and download the user program 
Compile the S7 program and download it into the AS. 

Compiling the OS project 
Prior to that compile the OS project in the SIMATIC Manager. 
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3.3.2 OS configuration 

Table 3-6 

Step Activity Screenshot 
1.  Open the OS project. 

In the opened WinCC Explorer, 
open the OS project and select 
“Properties” in the context menu. 

 

 

2.  In the “General” tab under “type:” 
select “Single-User Project”. 
Confirm the selection and the 
message that appears with the 
“OK” button. 

 
3.  Prevent deleting the startup list by 

pressing the “No” button. 
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Step Activity Screenshot 
4.  Close the WinCC Explorer. 

 
NOTE 
The changes will only become 
effective when the WinCC Explorer 
has been closed and opened 
again. 

 

 

3.3.3 Activating Runtime 

After the OS project has been closed, you can open it again and activate 
Runtime. 

 

3.3.4 Particularities at downloading of OS Project Modifications 

If OS and ES are operated in a computer, no load process must be per-
formed as all of the required data already exists. Here, executing the 
“Compile OS“ function is sufficient. 

Analog to the “Download changes“ function, the “Compile changes“ 
function can be executed at stand-alone systems without terminating the 
process mode of the OS. 
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4 ES/OS Client and OS Server 

4.1 Configuration Description 

For a server-client structure with only two computers, the ES serves as the 
OS client at the same time. In the configuration, three PC stations are 
provided for. 

Figure 4-1 

 

  

Terminal bus

Plant bus

OSES / OS-Client

 

PCS 7 configuration 
Figure 4-2 
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4.2 Required Hardware and Software Licenses 

Hardware 
The following hardware is recommended for this configuration and can be 
ordered via the Siemens mall. Your selected operating system and the 
system software SIMATIC PCS 7 is then preinstalled accordingly. 

Table 4-1 

Component Product information Operating system Plantbus 
transition 

SIMATIC PCS 7 ES/OS IL 
547B BCE WXP 

Windows XP SP3 RJ45 
network card 

1 x ES 

SIMATIC PCS 7 ES/OS IL 
547B IE WXP 

Windows XP SP3 CP 1613 A2 

SIMATIC PCS 7 OS server 
IL 547B BCE SRV03 

Windows server 2003 (R2) RJ45 
network card 

1 x OS 
server 

SIMATIC PCS 7 OS server 
IL 547B IE SRV03 

Windows server 2003 (R2) CP 1613 A2 
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Software licenses 
In the following the different software/license packages required for this 
configuration selection have been listed. 

An OS server can provide up to 8500 POs with the respective software 
package - depending on the scope of the project. In addition to the 
Engineering Software, an OS client software must be installed on the ES. 

Table 4-2 

Software Name 

1 x OS software server SIMATIC PCS 7 OS Software Server V7.1 
• 250 PO 
• 1000 PO 
• 2000 PO 
• 3000 PO 
• 5000 PO 
• 8500 PO 

1 x engineering software SIMATIC PCS 7 Engineering Software V7.1 
AS/OS 

• PO "unlimited" 
1 x OS software client SIMATIC PCS 7 OS Software Client V7.1 

 

Note The “Rental License”, which is restricted to 30 operating days or 50 
hours, provides additional licenses for engineering of short-term projects. 
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4.3 Step-by-step Configuration 

Note The following instruction was generated on the basis of Windows XP SP3 
and PCS 7 V7.1. 

For the plantbus transitions, CP1613 is used as an example. A clock 
synchronization is activated. 

The PC stations in the test setup are called: 

• ES/OS client (“ES25”): ES25 
• OS server (“Server”):   ES21 

 

4.3.1 Preparatory Steps 

Create a project folder in the OS server and release it. You can then 
transmit OS data configured on the Engineering Station to the OS. 

4.3.2 ES Configuration 

Generating the multiproject 
As a basis for the following instruction, all PC stations must be physically 
networked according to Figure 4-1 (S.22). Furthermore, a multiproject must 
have been generated on the ES in which the AS has already been 
configured regarding hardware and software. 

Then you can start with the following CPU and CP settings. 

AS settings 
This example describes a path where the OS server defines the master 
time. 

Note Further options of clock synchronization are described in detail in the 
Manual “PCS 7 – Configuration Manual Operator Station, clock 
synchronization and life signal monitoring”. 
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Table 4-3 

Step Activity Screenshot 
1.  Open the HW Config of the AS. 

Select the CPU and choose 
“Object Properties…” from the 
context menu. 

 
2.  Go to the “Diagnostics/clock” tab. 

In the section under “Clock”, set 
“As slave” for the AS under 
“Synchronization Type”. 
Confirm the setting with “OK”. 
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Step Activity Screenshot 
3.  Open the context menu of the CP 

and select “Object Properties…”. 

 
4.  Go to the “Time-of-Day 

Synchronization” tab. 
Activate the option “Activate 
SIMATIC time-of-day 
synchronization”. 
Confirm the setting with “OK”. 

 
5.  Save and compile the configuration 

with “Station > Save and 
Compile”. 
Close the HW Config. 

 

 



 
ES/OS Client and OS Server

Minimal Configurations PCS 7 V7.1 24023824
 

Version 3.3 13.09.2011 28/118
 

C
op

yr
ig

ht
 ©

 S
ie

m
en

s 
A

G
 2

01
1 

A
ll 

rig
ht

s 
re

se
rv

ed
 

Generating the ES PC station 
In order to be able to test the OS project on the ES, generate a PC station 
for the ES with WinCC Application. 

Table 4-4 

Step Activity Screenshot 
1.  In the “Component view”, open 

the context menu of the project 
and insert a new PC station via 
“Insert New Object > 
SIMATIC PC Station”. 
Change the name of the PC station 
so that it corresponds to the name 
of the local computer in the 
network. 

 
2.  Open the HW Config of the PC 

station of the OS server. 

 
3.  From the object catalog (“View > 

Catalog”), add a “WinCC 
Application” and a network card of 
the type “CP1613”. 
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Step Activity Screenshot 
4.  Under “Subnet”, select the Plant 

Bus or create it with the button 
“New”. 
Assign the respective MAC 
address to the CP 1613. 
Deactivate the option “IP protocol 
is being used”. 
Confirm the settings with “OK”. 

5.  Open the context menu of the CP 
and select “Object Properties…”. 

6.  Select the “Options” tab and 
checkmark the “Time of day” box. 
Confirm the setting with “OK”. 

 
7.  Save and compile via menu item 

“Station > Save and 
Compile”. 
Close the HW Config. 

 

8.  
optional 

In the SIMATIC Manager, delete 
the OS application of the PC 
station of the ES as it is not 
required in our example. 
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Generating the OS server PC station 
Table 4-5 

Step Activity Screenshot 
1.  In the “Component view”, open the 

context menu of the project and 
insert a new PC station via 
“Insert New Object > SIMATIC 
PC Station”. You can choose its 
name freely. 

 
2.  Open the HW Config of the PC 

station with the context menu. 

 
3.  From the object catalog (“View > 

Catalog”), add a “WinCC 
Application” and a network card of 
the type “CP1613”. 

 
4.  Under “Subnet”, select the Plant 

Bus or create it with the button 
“New…”. 
Assign the respective MAC 
address to the CP 1613. 
Deactivate the option “IP protocol 
is being used”. 
Confirm the settings with “OK”. 
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Step Activity Screenshot 
5.  Open the context menu of the 

CP1613 and select “Object 
Properties…”. 

6.  Switch to the “Options” tab and 
checkmark the “Time of day” box. 
Confirm the setting with “OK”. 

 
7.  Save and compile via menu item 

“Station > Save and 
Compile”. 
Close the HW Config. 

 

8.  In the SIMATIC Manager, open the 
properties dialog of the OS project 
of the OS server. 
Switch to the “Target OS and 
Standby OS Computer” tab. 
Under “Standby-OS”, select  
“<none>”. 
Then hit the “Search…” button. 
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Step Activity Screenshot 
9.  Navigate by the drop down menu 

to the enable project folder of the 
OS server (see 4.3.1 Preparatory 
Steps). 
Hit the “Save” button. 

 
10.  Check the selected path and 

confirm with the “OK” button. 

 
11.  Acknowledge the information 

dialog with “Yes”. 
 

 

Generating the client PC station 
Table 4-6 

Step Activity Screenshot 

1.  In the “Component view”, open the 
context menu of the project and 
insert a new PC station via 
“Insert New Object > 
SIMATIC PC Station”. You 
can choose its name freely. 
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Step Activity Screenshot 

2.  Open the HW Config of the PC 
station of the OS client. 

 
3.  From the object catalog (“View > 

Catalog”), add a “WinCC 
Application Client”. 

4.  Save and compile via menu item 
“Station > Save and 
Compile…”. 
Close the HW Config. 

 

5.  Open the context menu of the PC 
station of the client in the SIMATIC 
Manager and select “Object 
Properties”. 
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Step Activity Screenshot 

6.  Under “Computer name”, enter the 
name of the PC, where the 
operating of the client shall be 
carried out. In the configuration on 
hand, this is the ES computer 
Confirm the entry with “OK”. 
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Configuring all relevant PC stations 
The function “Configure PC station” transfers the project configuration to 
one or more PLCs. First configure the local components configurator of the 
ES and then the OS connected to the plantbus. 

Table 4-7 

Step Activity Screenshot 
1.  Configure the component 

configurator of the ES. Open the 
ES context menu and select “PLC 
> Configure…”. 

 
2.  Under “Accessible computers”, 

choose the PC which is provided 
for configuration. 
 
NOTE 
If you chose the option “Computer 
name identical to the PC station 
name” in the component view 
“Object Properties” for the PC 
station, the component 
configurator directly displays the 
target computer to be configured. 
 
With “Display”, you can have the 
current configuration of the PC 
station displayed. 
Hit the “Configure…” button. 
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Step Activity Screenshot 
3.  In the displayed window you see 

how the PC station is configured. 
Confirm this setting with “OK”. 

4.  Acknowledge the information 
dialog with “OK”. 

 
5.  Finally, you receive the following 

message in the bottom window: 
“Transfer completed successfully.” 
Close the configuration dialog box. 

6.  Please configure the component 
configurator of the OS server 
analog to step 1 to 5. 
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Configuration and download of the AS/OS communication 
In the following, the connections between the PC stations and the AS in 
NetPro are configured and downloaded into the individual stations. 

Note For station granular configuration, the subnets of the individual 
subprojects must be joined beforehand. 

 
Table 4-8 

Step Activity Screenshot 
1.  Open NetPro. 

Select the WinCC application of 
the ES and open the context 
menu. Choose “Insert New 
Connection”. 

 
2.  In the “Connection Partner” 

window, select the CPU of the AS. 
Make sure that in the “Connection” 
field a “S7 connection” has been 
selected. 
Confirm the setting with “OK”. 
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Step Activity Screenshot 
3.  In the “General” tab, in 

“Connection identification” change 
the “Local ID” into a meaningful 
name, like AS25. 
Confirm the entries with “OK”. 

 
4.  Repeat steps 1 to 3 for connecting 

the OS server to the AS. 
It is important here, that the 
connections of the ES and the OS 
server with the AS have identical 
names. 
Then, save and compile the 
configuration with the menu item 
“Network > Save and 
compile…”. 
Choose the option “Compile and 
check everything” and confirm with 
“OK”. 

 

5.  Select the ES and then download 
the connections with the menu 
item “PLC > Download to 
Current Project > Selected 
Stations”. 
Download the OS server and the 
AS in the same way. 
Then close NetPro. 

 
 

Compile and download the user program 
Compile the S7 program and download it into the AS. 

Compiling the OS server project 
Compile the OS server project in the SIMATIC Manager. 

Look out for the correct OS assignment to the server in Plant View. 
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Assigning the server package 
Table 4-9 

Step Activity Screenshot 

1.  Select the OS application of the 
OS client and select “Assign OS 
server…” in the context menu. 

 
2.  Then select the respective OS 

project and acknowledge with 
“OK”. 

 
3.  Confirm the successful download 

of the package with “OK”. 
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4.3.3 OS Configuration 

Activating the clock synchronization 
Still on the ES, the necessary settings are activated in the OS projects by 
OS server and OS client. 

Table 4-10 

Step Activity Screenshot 
1.  Open the OS server project. 

 
2.  Open the editor “Time 

synchronization” with the context 
menu. 
 
Activate the checkbox 
“Synchronization via System Bus 
(Master, Slave)”. 
In “Access point 1”, select 
“CP1613(ISO)” and activate the 
option “Master”. 
Confirm the setting with “OK”. 
 
NOTE 
If the ES server, as opposed to the 
OS server, does not have a 
CP 1613, the settings for the clock 
synchronization cannot be 
executed here. The clock 
synchronization settings must, in 
this case, be executed on the OS 
server itself after the download of 
the OS project. 
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Step Activity Screenshot 
3.  Close the OS server project.  
4.  Open the OS client project. 

5.  Open the editor “Time 
synchronization” with the context 
menu. 
 
Activate the checkbox 
“Synchronization via Terminal Bus 
(Slave)” and select “Use the time 
from a connected WinCC server”. 
Confirm the setting with “OK”. 

 

6.  Close the OS client project.  
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Download the OS project to the OS server 
After the clock synchronization has been configured on the ES side, the OS 
project can be downloaded to the OS server. 

Table 4-11 

Step Activity Screenshot 
1.  In the SIMATIC Manager, select 

the OS project of the OS server 
and select “PLC > Download” 
from the context menu. 

 
2.  Downloading the OS project for the 

first time requires a complete 
download. 
Start the download with “OK”. 

3.  After the successful download, the 
OS project is located on the OS 
server in the intended folder. 
Confirm this with “OK”. 
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OS configuration on the OS server 
After the first download, the following step-by-step instructions for time 
synchronization must be checked and corrected if necessary. 

 
Table 4-12 

Step Activity Screenshot 
1.  Open the OS project on the OS 

server. 
 

2.  Open the editor “Time 
synchronization” with the context 
menu. 

 

Activate the checkbox 
“Synchronization via System Bus 
(Master, Slave)”. 
In “Access point 1”, check or 
select “CP1613(ISO)” and press 
the “Master” radio button. 
 
Confirm the settings always with 
“OK”. 

 

 

4.3.4 Activating Runtime 

Open the OS project on the OS server and activate Runtime. 

Then change to the ES computer and open the OS client project. Here, 
activate Runtime, too. 

 

4.3.5 Particularities at downloading of OS Project Modifications 

Delta-download 
Before OS compilation and download are possible on the ES, the OS client 
Runtime must be deactivated and the WinCC project must be closed. 
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Entire download 
Before OS compilation and download are possible from the ES, the  
OS client Runtime as well as the OS server Runtime must be deactivated 
and the WinCC projects must be closed. 
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5 ES/OS-Master and OS-Standby 

 

CAUTION The configuration described here only works with WinCC V7.0 SP2 
HF5 or higher. 

 

5.1 Configuration Description 

The configuration refers to the use of the ES as an additional OS (see 
chapter 3 ES/OS Stand-alone Systems). Moreover, another OS stand-
alone system is configured and operated in redundancy with the ES/OS 
combination. After the download the redundancy settings in the WinCC 
Explorer must be set. 

Note In our example, the redundancy settings in WinCC are made in such a 
way that the ES is defined as the master OS and the OS as a standby 
OS. 

 
 

Hardware configuration 
Figure 5-1 

Terminal bus

Plant bus

OS-Standby

COM-Cabel

Redundancy

ES / OS-Master
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PCS 7 configuration 
Figure 5-2 

 

Particularities / restrictions 
Due to the nontypical PCS 7 configuration with only one OS there are 
differences in the system behavior which must be considered: 

• The first activated OS takes on the master role. 

• For the complete download, Runtime must be deactivated for both 
computers, and the WinCC Explorer must be closed. During this time, 
neither operator actions nor archiving is possible. 

• For a delta-download, Runtime on the ES must be closed again for 
compiling the OS. It can then be re-activated for testing the modified OS 
functions. For the downloading, Runtime must be terminated and the 
WinCC project must be closed.  
The following restrictions result: 

– No operator actions can take place at the ES computer at that time. 

 

NOTICE If Runtime remains active on the ES during the OS compilation, it might 
happen - depending on the changes made - that a subsequent delta-
download is carried out incompletely and results in errors. Afterwards, 
only a complete download will be possible. 

 
 

• Runtime being active on the ES computer results in the runtime archive 
being stored under the multiproject path. Therefore, they are also 
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included into the ZIP file during archiving and cause increased storage 
space as well as archiving times. 
Workaround: 

– Deactivate Runtime on the ES computer. 

– Reset archive in the OS project on the ES computer and close the 
entire PCS 7 project. 

After archiving and reactivating Runtime, the archives are updated 
again. Please note that more time will be needed for checking. 

 

5.2 Required Hardware and Software Licenses 

Hardware 
The following hardware is recommended for this configuration and can be 
ordered via the Siemens mall. Your selected operating system and the 
system software SIMATIC PCS 7 is then preinstalled accordingly. 

Table 5-1 

Components Product information Operating system Plantbus transition
1 x ES SIMATIC PCS 7 ES/OS 

IL 547B BCE WXP 
Windows XP SP3 RJ45 

network card 
 SIMATIC PCS 7 ES/OS 

IL 547B IE WXP 
Windows XP SP3 CP 1613 A2 

1 x OS single 
station 

SIMATIC PCS 7 ES/OS 
IL 547B BCE WXP 

Windows XP SP3 RJ45 
network card 

 SIMATIC PCS 7 ES/OS 
IL 547B IE WXP 

Windows XP SP3 CP 1613 A2 

1 x redundancy RS 232 connecting cable, 
10 m 
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Software licenses 
In the following, the different software/license packages required for this 
configuration selection have been listed.  

In the selected configuration, the number of the POs is restricted to no 
more than 2000. 

Table 5-2 

Software Name 

1 x engineering software for the 
combined station 

SIMATIC PCS 7 Engineering Software V7.1 AS/OS 
Runtime license 

• 250 PO 
• 1000 PO 
• 2000 PO 

1 x OS software single station SIMATIC PCS 7 OS Software Single Station V7.1 
• 250 PO 
• 1000 PO 
• 2000 PO 
• 3000 PO 
• 5000 PO 

1 x redundancy upgrade WinCC/Redundancy V7.0 
 

Note The “Rental License”, which is restricted to 30 operating days or 50 
hours, provides additional licenses for engineering of short-term projects. 
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5.3 Step-by-step Configuration 

Note The following instruction was generated on the basis of Windows XP SP3 
and PCS 7 V7.1. 

For the plantbus transitions, CP1613 is used as an example. Additionally, 
the clock synchronization is activated.  

The PC stations in the test setup are called: 

• ES/OS-Master (“ES25”):         ES25 
• OS-Stanby (“ServerStby”):      ES21 

 
 

 

5.3.1 ES Configuration 

Generating the multiproject 
As a basis for the following instruction, all PC stations must be physically 
networked according to Figure 5-1. Furthermore, a multiproject must have 
been created on the ES in which the AS has already been configured 
regarding hardware and software. 

Then you can start with the following CPU and CP settings. 

AS settings for the clock synchronization 
Evaluation of the process data requires all components of the process 
control system to work with an identical clock, so that messages can be 
allocated in the correct temporal sequence. 

Below, a path is described where the redundant OS single stations define 
the master time. 

Note Further options of clock synchronization are described in detail in the 
Manual “PCS 7 – Configuration Manual Operator Station, clock 
synchronization and life signal monitoring”. 
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Table 5-3 

Step Activity Screenshot 

1.  Open the HW Config of the AS. 
Select the CPU and choose 
“Object Properties…” from the 
context menu. 

 
2.  Go to the “Diagnostics/Clock” tab. 

In the section under “Clock”, set 
“As slave” for the AS under 
“Synchronization Mode”. 
Confirm this setting with “OK”. 

 
3.  Open the context menu of the CP 

and select “Object Properties…”. 



 
ES/OS-Master and OS-Standby

Minimal Configurations PCS 7 V7.1 24023824
 

Version 3.3 13.09.2011 51/118
 

C
op

yr
ig

ht
 ©

 S
ie

m
en

s 
A

G
 2

01
1 

A
ll 

rig
ht

s 
re

se
rv

ed
 

Step Activity Screenshot 

4.  Go to the “Time-of-Day 
Synchronization” tab. 
Activate the option “Activate 
SIMATIC time-of-day 
synchronization”. 
Confirm the setting with “OK”. 

 
5.  Save and compile via menu item 

“Station > Save and 
Compile”. 
Close the HW Config. 

 

 

Generating the ES PC station 
In order to take the OS project on the ES into operation, we generate a PC 
station for the ES with WinCC application. 

Table 5-4 

Step Activity Screenshot 

1.  In the “Component view”, open 
the context menu of the project 
and insert a new PC station via 
“Insert New Object > 
SIMATIC PC Station”. 
Change the name of the PC station 
so that it corresponds to the name 
of the local computer in the 
network. 
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Step Activity Screenshot 

2.  Open the HW Config of the PC 
station of the ES with the context 
menu. 

 
3.  From the object catalog (“View > 

Catalog”), add a “WinCC 
Application” and a network card of 
the type “CP1613”. 

4.  Under “Subnet”, select the Plant 
Bus or create it with the button 
“New…”. 
Assign the respective MAC 
address to the CP 1613. 
Deactivate the option “IP protocol 
is being used”. 
Confirm the settings with “OK”. 

5.  Open the context menu of the CP 
and select “Object Properties…”. 
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Step Activity Screenshot 

6.  Select the “Options” tab and 
checkmark the “Time of day” box. 
Confirm the setting with “OK”. 

 
7.  Save and compile via the menu 

item “Station > Save and 
Compile…”. 
Close the HW Config. 

 

8.  
optional 

In the SIMATIC Manager, delete 
the OS project of the PC station of 
the ES as it is not required in our 
example. 

 

 

Generating the standby OS PC station 
Table 5-5 

Step Activity Screenshot 

1.  In the “Component view”, open the 
context menu of the project and 
insert a new PC station via 
“Insert New Object > 
SIMATIC PC Station”. You can 
choose its name freely. 
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Step Activity Screenshot 

2.  Open the HW Config of the PC 
station of the standby OS with the 
context menu. 

 
3.  From the object catalog (“View > 

Catalog”), add a “WinCC 
Application” (no WinCC 
Application Stby!) and a network 
card of the type “CP1613”. 

4.  Under “Subnet”, select the Plant 
Bus or create it with the button 
“New…”. 
Assign the respective MAC 
address to the CP 1613. 
Deactivate the option “IP protocol 
is being used”. 
Confirm the settings with “OK”. 

5.  Open the context menu of the CP 
and select “Object Properties…”. 
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Step Activity Screenshot 

6.  Select the “Options” tab and 
checkmark the “Time of day” box. 
Confirm the setting with “OK”. 

 
7.  Save and compile via menu item 

“Station > Save and 
Compile…”. 
Close the HW Config. 

 

8.  In the SIMATIC Manager, open the 
properties dialog of the OS project. 
Switch to the “Target OS and 
Standby OS Computer” tab. 
Checkmark the “Create/update 
archive tags” box and deselected 
“Transfer to central archive server”.
Press the “Search” button. 

 
9.  Navigate by the drop down menu 

to the enable project folder of the 
OS server (see 5.3.1 Preparatory 
Steps). 
Hit the “Save” button. 
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Step Activity Screenshot 

10.  Check the path in the box “Path to 
the Target OS Computerr”. 
Confirm this with “OK”. 

 
11.  Acknowledge the information 

dialog with the “Yes” button. 
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Configuring the PC stations 
The function “Configure PC station” transfers the project configuration to 
one or more PLCs. First configure the local components configurator of the 
ES and then the all the other PC Stations connected with the plantbus. 

Table 5-6 

Step Activity Screenshot 

1.  Configure the component 
configurator of the ES. Select the 
PC station of the ES and choose 
“PLC > Configure…” from the 
context menu. 

2.  Under “Accessible computers”, 
choose the PC which is provided 
for configuration. 
 
NOTE 
If you chose the option “Computer 
name identical to the PC station 
name” in the component view 
“Object Properties” for the PC 
station, the component 
configurator directly displays the 
target computer to be configured. 
 
With “Display”, you can have the 
current configuration of the PC 
station displayed. 
Hit the “Configure…” button. 
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Step Activity Screenshot 

3.  In the displayed window you see 
how the PC station is configured. 
Confirm this setting with “OK”. 

 
4.  Acknowledge the information 

dialog with “OK”. 
 

5.  Finally, you receive the following 
message in the bottom window:  
“Transfer completed successfully.” 
Close the configuration dialog box. 

6.  Please configure the component 
configurator of the OS server 
analog to steps 1 to 5. 

 

Configuration and download of the AS/OS communication 
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In the following, the connections between the PC stations and the AS in 
NetPro are configured and downloaded into the individual stations. 

Note For station granular configuration, the subnets of the individual 
subprojects must be joined beforehand. 

 
Table 5-7 

Step Activity Screenshot 

1.  Open NetPro. 
Select the WinCC application of 
the ES and open the context 
menu. 
Choose “Insert New Connection”. 

 
2.  In the “Connection Partner” 

window, select the CPU of the AS. 
Make sure that in the “Connection” 
field a “S7 connection” has been 
selected. 
Confirm the setting with “OK”. 
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Step Activity Screenshot 

3.  In the “General” tab, in 
“Connection identification” change 
the “Local ID” into a meaningful 
name, like AS25. 
Confirm the settings with “OK”. 

 
4.  Create the connection between the 

standby OS and the AS in the 
same way, by repeating steps 1 to 
3. 
It is important that the connection 
has the same name as the 
connection of the ES to the AS. 
Then, save and compile the 
configuration with the menu item 
“Network > Save and 
compile…”. 
 
Choose the option “Compile and 
check everything” and confirm with 
“OK”. 

 

5.  Mark the ES and then download 
the connections with the menu 
item “PLC > Download to 
Current Project > Selected 
Stations”. 
Download the standby OS and the 
AS in the same way. 
Then close NetPro.  

 

Compile and download the user program 
Compile the S7 program and download it into the AS. 

Compiling the OS project 
Compile the OS project in the SIMATIC Manager. 

Look out for the correct OS assignment to the server in Plant View. 
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5.3.2 OS Configuration 

OS configuration on the Engineering Station 
Conversion from multi-place to single-place systems is made on the ES, as 
well as settings for redundancy and clock synchronization. 

Note For this particular configuration, it is necessary to complete the 
redundancy setting in the WinCC Explorer of the standby OS after the 
entire download. 

 
 

Table 5-8 

Step Activity Screenshot 

1.  Open the OS-Standby project on 
the ES computer. 
In the opened WinCC Explorer, 
open the OS project and select 
“Properties” in the context menu. 
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Step Activity Screenshot 

2.  In the “General” tab, under 
“type:”, select “Single-user project”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Confirm the selection and the 
message that appears with the 
“OK” button. 

 

 
3.  Via the “Options” tab, checkmark 

the OS project option “Allow 
activation on ES”. With this setting 
Runtime can be simulated on the 
ES. 

 

4.  Prevent deleting the startup list by 
pressing the “No” button. 
Confirm the message that appears 
with the “OK” button. 
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Step Activity Screenshot 

5.  Open the editor “Redundancy” with 
the context menu. Activate the 
option box “Activate Redundancy”. 
 
Activate the option box “Default 
Master”. 
If necessary, adjust the 
redundancy properties in “Optional 
Settings” to your requirements. 
If you do not wish to operate the 
RS 232 redundancy cable at the 
COM1 interface, then these 
settings must later be performed 
on the OS itself (see section “OS 
configuration on the OS”). 

 
To complete the redundancy 
settings for the ES, the partner 
server must be selected. 
Select the standby OS as 
redundant partner via the 
“Browse…” button out of the PC 
network. 
Confirm the settings with “OK”. 

 

6.  

Control the redundancy settings 
before you confirm via “OK” button. 
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Step Activity Screenshot 

7.  Open the “Time Synchronization” 
editor. 
 
Here, activate the checkbox 
“Synchronization via System Bus 
(Master, Slave)”. 
In “Access point 1”, select 
“CP1613(ISO)” and activate the 
“Master” radio button. 
Confirm the settings with “OK”. 
 
NOTE 
If the ES server does not have a 
CP 1613, the settings for the clock 
synchronization cannot be 
executed here. The clock 
synchronization settings must, in 
this case, be executed on the 
standby OS itself after 
downloading the OS project. 

 
8.  Close the OS project.  
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Loading OS project to the standby OS 
After the redundancy and clock synchronization have been configured on 
the ES side, and the OS project has been closed, download the OS project 
onto the standby OS. 

Table 5-9 

Step Activity Screenshot 

1.  In the SIMATIC Manager, select 
the standby OS and select “PLC > 
Download” from the context 
menu. 

 
2.  Downloading the OS project for the 

first time requires a complete 
download. 
Start the download with “OK”. 

3.  After the successful download, the 
OS project is located on the 
standby OS in the intended folder. 
Confirm this with “OK”. 
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OS configuration on the standby OS 
For this special configuration, it is necessary to make the redundancy 
settings before the download. 

If the engineering station has no CP 1613 as opposed to the OS, or the 
RS 232 redundancy cable is not connected at COM1 there, the following 
step-by-step instructions must be performed. Otherwise, we generally 
advise you to check those after the project download onto the target 
system. 

Note Normally, all configuration works are executed on the ES for the purpose 
of consistent data management, so that no WinCC engineering licenses 
are required on the OS. Nevertheless, a license free time window of one 
hour is available after each opening of the WinCC Explorer for WinCC 
configuration works. 

 
 

Table 5-10 

Step Activity Screenshot 

1.  Open the WinCC Explorer on the 
standby OS. 

 

2.  Open the editor “Redundancy” with 
the context menu. 
 
Select the standby OS as 
redundant partner via the 
“Browse…” button out of the PC 
network. 
Confirm the settings with “OK”. 
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Step Activity Screenshot 

Here, uncheck the “Default Master” 
checkbox. 
Select the ES computer as 
redundant partner via the 
“Browse…” button. 
Check whether your desired 
checkboxes are activated at 
“Optional Settings”. 
 
Confirm the settings with “OK”. 

 
Confirm the information dialog with 
the “OK” button. 

 
3.  Open the editor “Time 

synchronization” with the context 
menu. 
 
Here, activate the checkbox 
“Synchronization via System Bus 
(Master, Slave)”. 
In “Access point 1”, check or select 
“CP1613(ISO)” and press the 
“Master” radio button. 
 
Confirm the settings always wih 
“OK”. 
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Step Activity Screenshot 

4.  If you made any changes in the 
WinCC Explorer project, close the 
OS project and open it again to 
activate the settings. 

 

 

5.3.3 Activating Runtime 

Successively start the OS project on the ES as well as on the standby OS. 
It is recommended to wait with activating the second Runtime until the start 
process of the first one is completed entirely. 

Regarding the redundancy, the online synchronization is active 
immediately. The mutual archive update, on the other hand, takes approx. 
10-15 min. 

 

5.3.4 Particularities at downloading of OS Project Modifications 

Delta-download 
For a delta-download, Runtime on the ES must be closed again for 
compiling the OS. It can then be re-activated for testing the modified OS 
functions. 

 

NOTICE If Runtime remains active on the ES during the OS compilation, it might 
happen - depending on the changes made - that a subsequent delta-
download is carried out incompletely and results in errors. Afterwards, 
only a complete download will be possible. 

 
For the downloading, Runtime must be terminated and the WinCC project 
must be closed. 
The following restrictions result: 

– No operator actions can take place at the ES computer at that time. 

Complete download 
For downloading the complete program, please note: 

1. Runtime must be deactivated on both PC stations and the WinCC 
project must be closed. 

2. Before Runtime is activated again on the standby OS, the redundancy 
settings must be made. 
Repeat the steps from Table 5-10 
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6 ES, OS-Master and OS-Standby 

6.1 Configuration Description 

During process operation the server pair runs completely in parallel and 
absolutely independent. If a server fails, there is always an equivalent 
redundant OS server. The servers supervise each other during the runtime 
and synchronize the project archives if necessary. 

The configuration is carried out via the ES. 

 

Hardware configuration 
Figure 6-1 
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PCS 7 configuration 
Figure 6-2 

 

6.2 Required Hardware and Software Licenses 

Hardware 
The following hardware is recommended for this configuration and can be 
ordered via the Siemens mall. Your selected operating system and the 
system software SIMATIC PCS 7 is then preinstalled accordingly. 

Table 6-1 

Component Product information Operating system Plantbus transition 

SIMATIC PCS 7 ES/OS 
IL 547B BCE WXP 

Windows XP SP3 RJ45 
network card 

1 x ES 

SIMATIC PCS 7 ES/OS 
IL 547B IE WXP 

Windows XP SP3 CP 1613 A2 

SIMATIC PCS 7 ES/OS 
IL 547B BCE WXP 

Windows XP SP3 RJ45 
network card 

2 x OS single 
stations 

SIMATIC PCS 7 ES/OS 
IL 547B IE WXP 

Windows XP SP3 CP 1613 A2 
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Software licenses 
In the following, the different software/license packagess required for this 
configuration selection have been listed. 

In the selected configuration as a redundant stand-alone system, the 
number of the POs is restricted to no more than 5000. 

Table 6-2 

Software Name 

1 x OS software redundant single 
station 

SIMATIC PCS 7 OS Single Station Redundancy 
V7.1 
• 250 PO 
• 1000 PO 
• 2000 PO 
• 3000 PO 
• 5000 PO 

1 x engineering software PCS 7 Engineering Software V7.1 AS/OS – PO 
"unlimited" 

 

Note The “Rental License”, which is restricted to 30 operating days or 50 
hours, provides additional licenses for engineering of short-term projects. 
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6.3 Step-by-step Configuration 

Note The following instruction was generated on the basis of Windows XP SP3 
and PCS 7 V7.1. 

For the plantbus transitions, CP1613 is used as an example. A clock 
synchronization is activated. 

The PC stations in the test setup are called: 

ES (“ES25”):                         ES25 
OS-Master (“Server”):          ES21 
OS-Standby (“ServerStby”): ES23 

 
 

 

6.3.1 ES Configuration 

Generating the multiproject 
As a basis for the following instruction, all PC stations must be physically 
networked according to Figure 6-1 (S.75). Furthermore, a multiproject must 
have been created on the ES in which the AS has already been configured 
regarding hardware and software. 

Then you can start with the following CPU and CP settings. 

AS settings 
Evaluation of the process data requires all components of the process 
control system to work with an identical clock, so that messages can be 
allocated in the correct temporal sequence. 

Below, a path is described where the redundant OS single stations define 
the master time. 

Note Further options of clock synchronization are described in detail in the 
Manual “PCS 7 – Configuration Manual Operator Station, clock 
synchronization and life signal monitoring”. 
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Table 6-3 

Step Activity Screenshot 
1.  Open the HW Config of the AS. 

Select the CPU and choose 
“Object Properties…” from the 
context menu. 

 
2.  Go to the “Diagnostics/Clock” tab. 

In the section under “Clock” set “As 
slave” for the AS under 
“Synchronization Type”. 
Confirm the setting with “OK”. 

 
3.  Open the context menu of the CP 

and select “Object Properties…”. 
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Step Activity Screenshot 
4.  Go to the “Time-of-Day 

Synchronization” tab. 
Activate the option “Activate 
SIMATIC time-of-day 
synchronization”. 
Confirm the setting with “OK”. 

 
5.  Save and compile the configuration 

with “Station > Save and 
Compile”. 
Close the HW Config. 

 

 

Generating the ES PC station 
In order to take the OS project on the ES into operation, we generate a PC 
station for the ES with WinCC application. 

Table 6-4 

Step Activity Screenshot 
1.  In the “Component view”, open 

the context menu of the project 
and insert a new PC station via 
“Insert New Object > 
SIMATIC PC Station”. 
Change the name of the PC station 
so that it corresponds to the name 
of the local computer in the 
network. 
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Step Activity Screenshot 
2.  Open the HW Config of the PC 

station of the ES with the context 
menu. 

 
3.  From the object catalog (“View > 

Catalog”), add a “WinCC 
Application” and a network card of 
the type “CP1613”. 

4.  Under “Subnet”, select the Plant 
Bus or create it with the button 
“New…”. 
Assign the respective MAC 
address to the CP 1613. 
Deactivate the option “IP protocol 
is being used”. 
Confirm the settings with “OK”. 



 
ES, OS-Master and OS-Standby

Minimal Configurations PCS 7 V7.1 24023824
 

Version 3.3 13.09.2011 76/118
 

C
op

yr
ig

ht
 ©

 S
ie

m
en

s 
A

G
 2

01
1 

A
ll 

rig
ht

s 
re

se
rv

ed
 

Step Activity Screenshot 
5.  Open the context menu of the CP 

and select “Object Properties…”. 

 
6.  Select the “Options” tab and 

checkmark the “Time of day” box. 
Confirm the setting with “OK”. 

 
7.  Save and compile via menu item 

“Station > Save and 
Compile”. 
Close the HW Config. 

 

8.  
optional 

In the SIMATIC Manager, delete 
the OS project of the PC station of 
the ES as it is not required in our 
example. 
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Generating the master OS PC station 
Table 6-5 

Step Activity Screenshot 
1.  In the “Component view”, open the 

context menu of the project and 
insert a new PC station via 
“Insert New Object > 
SIMATIC PC Station”. You 
can choose its name freely. 

 
2.  Open the HW Config of the PC 

station of the standby OS with the 
context menu. 

 
3.  From the object catalog (“View > 

Catalog”), add a “WinCC 
Application” and a network card of 
the type “CP1613”. 

 
4.  Under “Subnet”, select the Plant 

Bus or create it with the button 
“New…”. 
Assign the respective MAC 
address to the CP 1613. 
Deactivate the option “IP protocol 
is being used”. 
Confirm the settings with “OK”. 
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Step Activity Screenshot 
5.  Open the context menu of the CP 

and select “Object Properties…”. 

6.  Select the “Options” tab and 
checkmark the “Time of day” box. 
Confirm the setting with “OK”. 

 
7.  Save and compile via menu item 

“Station > Save and 
Compile…”. 
Close the HW Config. 
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Generating the standby OS PC station 
Table 6-6 

Step Activity Screenshot 
1.  In the “Component view”, open 

the context menu of the project 
and insert a new PC station via 
“Insert New Object > 
SIMATIC PC Station”. You can 
choose its name freely. 

 
2.  Open the HW Config of the PC 

station of the standby OS with the 
context menu. 

 
3.  From the object catalog (“View > 

Catalog”), add a “WinCC 
Application (stby)” and a network 
card of the type “CP1613”. 
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Step Activity Screenshot 
4.  Under “Subnet”, select the Plant 

Bus or create it with the button 
“New…”. 
Assign the respective MAC 
address to the CP 1613. 
Deactivate the option “IP protocol 
is being used”. 
Confirm the settings with “OK”. 

5.  Open the context menu of the CP 
and select “Object Properties…”. 

 
6.  Select the “Options” tab and 

checkmark the “Time of day” box. 
Confirm the setting with “OK”. 

 
7.  Save and compile via menu item 

“Station > Save and 
Compile…”. 
Close the HW Config. 
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Configuring all PC stations 
The function “Configure PC station” transfers the project configuration to 
one or more PLCs. First configure the local components configurator of the 
ES and then the OS connected to the plantbus. 

Table 6-7 

Step Activity Screenshot 
1.  Configure the component 

configurator of the ES. Select the 
PC station of the ES and choose 
“PLC > Configure…” from the 
context menu. 

 
2.  Under “Accessible computers”, 

choose the PC which is provided 
for configuration. 
 
NOTE 
If you chose the option “Computer 
name identical to the PC station 
name” in the component view 
“Object Properties” for the PC 
station, the component 
configurator directly displays the 
target computer to be configured. 
 
With the button “Display”, you can 
have the current configuration of 
the PC station displayed. 
Hit the “Configure…” button. 
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Step Activity Screenshot 
3.  In the displayed window you see 

how the PC station is configured. 
Confirm this setting with “OK”. 

 
4.  Acknowledge the information 

dialog with “OK”. 
 

5.  Finally, you receive the following 
message in the bottom window:  
“Transfer completed successfully.” 
Close the configuration dialog box. 

6.  Please configure the component 
configurator of the master and the 
standby OS analog to steps 1 to 5. 
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Configuration and download of the AS/OS communication 
In the following, the connections between the PC stations and the AS in 
NetPro are configured and downloaded into the individual stations. 

Note For station granular configuration, the subnets of the individual 
subprojects must be joined beforehand. 

 
Table 6-8 

Step Activity Screenshot 
1.  Open NetPro. 

Select the WinCC application of 
the ES and open the context 
menu. Choose “Insert New 
Connection”. 

 
2.  In the “Connection Partner” 

window, select the CPU of the AS. 
Ensure that in the “Connection” 
field a “S7 connection” has been 
selected. 
Confirm the setting with “OK”. 
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Step Activity Screenshot 
3.  In the “General” tab, in 

“Connection identification” change 
the “Local ID” into a meaningful 
name, like AS1. 
Confirm the settings with “OK”. 

 
4.  Repeat steps 1 to 3 for connecting 

the master OS and the standby OS 
to the AS. 
It is important that the connection 
of master OS, standby OS and ES 
to the AS have identical names. 
Then, save and compile the 
configuration with the menu item 
“Network > Save and 
compile…”. 
 
Choose the option “Compile and 
check everything” and confirm with 
“OK”. 

 

5.  Mark the ES and then, over the 
menu item load “PLC > 
Download to Current 
Project > Selected 
Stations”. 
Download the AS, master OS, and 
standby OS in the same way. 
Then close NetPro.  
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Master/standby settings on the ES 
Here you make the master/standby assignment and select the download 
paths. 

Table 6-9 

Step Activity Screenshot 

1.  In the SIMATIC Manager, open the 
properties dialog of the master OS. 
Switch to the “Target OS and 
Standby OS Computer” tab. 
In the “Standby-OS” drop-down 
menu, select “OS_(StBy)(21)”. 
Checkmark the “Create/update 
archive tags” box and deselected 
“Transfer to central archive server”.
Press the “Search” button. 

 
2.  Navigate by the drop down menu 

to the enable project folder of the 
OS server (see 6.3.1 Preparatory 
Steps). 
Hit the “Save” button. 

 
3.  Check the path in the box “Path to 

the Target OS Computer”. 
Confirm this with “OK”. 
Also confirm the message box that 
appears with the “OK” button. 
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Step Activity Screenshot 

4.  Open the Properties dialog of the 
standby OS. 
Switch to the “Target OS and 
Master OS Computers” tab. 
Verify that the master OS has also 
been entered in “Master OS”. 
Hit the “Search…” button to 
choose the storage path of the OS 
data. 

 
5.  Navigate by the drop down menu 

to the enable project folder of the 
OS standby server (see 6.3.1 
Preparatory Steps). 
Hit the “Save” button. 

 
6.  Check the path in the box “Path to 

the Target OS Computer”. 
Confirm this with “OK”. 

 
 

 

Compile and download the user program 
Compile the S7 program and download it into the AS. 

Compiling the OS project 
Compile the OS project of the master OS in the SIMATIC Manager. 

Look out for the correct OS assignment to the server in Plant View. 
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6.3.2 OS Configuration 

OS configuration on the Engineering Station 
Conversion from multi to single place systems is made on the ES, as well 
as settings for redundancy and clock synchronization. 

Table 6-10 

Step Activity Screenshot 
1.  Open the OS project of the master 

OS on the ES computer. 
In the opened WinCC Explorer, 
open the OS project and select 
“Properties” in the context menu. 
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Step Activity Screenshot 

 

2.  In the “General” tab under “type:”, 
select “Single-user project”. 
Confirm the selection and the 
message that appears with the 
“OK” button. 

 
3.  Prevent deleting the startup list by 

pressing the “No” button. 

 
4.  Open the editor “Redundancy” with 

the context menu. 
 
Activate the option box “Default 
Master”. 
Under “Redundanter Partner 
Sever:” the standby OS must be 
entered. 
Check whether your desired 
checkboxes are activated at 
“Optional Settings”. 
If you do not wish to operate the 
RS 232 redundancy cable at the 
COM1 interface, then these 
settings must later be performed 
on the OS itself (see section “OS 
configuration on the Operator 
Station”). 
Confirm the settings with “OK”. 
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Step Activity Screenshot 
5.  Open the editor “Time 

synchronization” with the context 
menu. 
 
Here, activate the checkbox 
“Synchronization via System Bus 
(Master, Slave)”. 
In “Access point 1”, select 
“CP1613(ISO)” and activate the 
“Master” radio button. 
Activate the option box  
“Display symbolic name of the 
access point”. 
Confirm the settings with “OK”. 
 
NOTE 
If the ES server does not have a 
CP 1613, the settings for the clock 
synchronization cannot be 
executed here. The clock 
synchronization settings must, in 
this case, be executed on both 
single stations itself after 
downloading the OS project. 

 

6.  Close the OS project.  
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Downloading OS project to the OS computers 
After the redundancy and clock synchronization have been configured on 
the ES side, the OS project can be downloaded to the master and standby 
OS. 

Table 6-11 

Step Activity Screenshot 
1.  In the SIMATIC Manager, select 

the master OS and select “PLC > 
Download” from the context 
menu. 

 
2.  Downloading the OS project for the 

first time requires a complete 
download. 
Start the download with “OK”. 

3.  After the successful download, the 
OS project is located on the master 
OS in the intended folder. 
Confirm this with “OK”. 
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Step Activity Screenshot 
4.  Repeat steps 1 to 3 to download 

the OS project to the standby OS. 
 

 

Configuration of the Operator Station 
If the engineering station has no CP 1613 as opposed to the OS, or the 
RS 232 redundancy cable is not connected at COM1 there, the following 
step-by-step instructions must be performed. Otherwise, we generally 
advise you to check the project settings after the project download onto the 
target systems. 

Note Normally, all configuration works are executed on the ES for the purpose 
of consistent data management, so that no WinCC engineering licenses 
are required on the OS. Nevertheless, a license free time window of one 
hour is available after each opening of the WinCC Explorer for WinCC 
configuration works. 
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Table 6-12 

Step Activity Screenshot 
1.  Open the OS project on the master 

OS. 
 

2.  Open the editor “Redundancy” with 
the context menu. 
 
Check the name of the master OS 
in the field “Server”. 
The “Default Master” checkbox 
must be activated. 
Also check whether, under 
“Redundant Partner Server:” the 
name of the standby OS has been 
entered correctly. 
Check whether your desired 
checkboxes are activated at 
“Optional Settings”. 
If you are operating the RS 232 
redundancy cable at a location 
different to the COM1 interface, 
you have to set the appropriate 
interface at “Serial connection to 
redundant partner:”. 
Confirm the settings with “OK”. 

 

3.  Open the editor “Time 
synchronization” with the context 
menu. 
 
Here, activate the checkbox 
“Synchronization via System Bus 
(Master, Slave)”. 
In “Access point 1”, check or select 
“CP1613(ISO)” and press the 
“Master” radio button. 
 
Confirm the settings always wih 
“OK”. 
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Step Activity Screenshot 
4.  If you made any changes in the 

WinCC Explorer project, close the 
OS project and open it again to 
activate the settings. 

 

5.  Repeat steps 1 to 6 on the standby 
OS with the following modifications 
for step 3 (redundancy): 
The “Default Master” checkbox 
must be deactivated. 
Also check, whether under 
“Redundant Partner Server:” the 
name of the master OS has been 
entered correctly. 

 
 

6.3.3 Activating Runtime 

Successively activate the OS project on the master OS as well as on the 
standby OS. It is recommended to wait with activating the second Runtime 
until the start process of the first one is completed entirely. 

Regarding the redundancy, the online synchronization is active 
immediately. The mutual archive update, on the other hand, takes approx. 
10-15 min. 
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7 Expansion by PCS 7 Web Option 

 

NOTE The Configuration OS Web Option has been tested with PCS 7 Version 
V7.1 and V7.0 SP2. 

 

Positioning 
To control automated processes via the Internet/Intranet, SIMATIC PCS 7 
offers control and monitoring options, the so called web options. 

This chapter describes the configuration of the web option on an ES/OS 
stand-alone system. The instruction can therefore be used as expansion for 
the following minimal configurations: 

• ES/OS stand-alone system (chapter 3) 

• Master ES/OS and Standby OS (chapter 5) 

 

Note In the following we configured exemplified the ES/OS stand-alone system 
as web server for stand alone systems with web options. Analog is it 
possible to configure the partner-OS as web server, without reservation 
of functionality for the web clients. 

If one of the redundant operator stations acts as web server, the 
redundancy is not available for the web clients. If this OS is in STOP 
mode, then web clients have no connection to the process either. 

The maximum number of Web clients is limited. For further information, 
please refer to chapter 7.1 "Web Configurations" in the "Attention" field. 

 

Function 
All relevant pictures and scripts are stored on the web server, so that they 
can be displayed and run via a web client. 

At the same time the web client accesses the stored process cell data on 
the web server via a TCP/IP connection. The user interface looks like an 
OS standard client with overview, work and key area. 

Among others, the following functions are available via the Web: 

• Control and monitoring functions that are also used on an OS Client 

• Message lists which can be called user-dependent just like on an 
OS Client. Messages can be acknowledged user-dependent. 

• Display of picture hierarchy according to plant hierarchy 

• Group display function including “Loop-in-Alarm” function. 

• Advanced status display 
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Note You can find further information regarding PCS 7 web options in the 
manual: 
“SIMATIC Process Control System PCS 7 OS Web Option > 
Overview of PCS 7 OS Web Option” 

 
 

7.1 Web Configurations 

In our example, the configuration of the web option represents an extension 
of the hard- and software configurations of chapter 3 "ES/OS Stand-alone 
Systems" and chapter 5 "ES/OS-Master and OS-Standby". 

Windows XP is installed on the ES/OS stand-alone systems that are 
expanded to web server. Thereupon the following restrictions result: 

 

WARNINGS As a rule, a stand-alone system with web server can be accessed by a 
maximum of three web clients simultaneously. 

The connection resources of Windows XP are limited to ten. However, a 
web client alone can claim up to four TCP/IP connections for certain 
actions. 

This is why collisions may occur under Windows XP in the case of three 
web clients operating at the same time. This is why we recommend 
linking a maximum of two web clients. 
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ES/OS stand-alone system as OS web server 
To control and monitor the system process, the OS web clients retrieve 
their project data using the Internet Explorer of the OS web server via the 
Intranet/Internet. 

 
Figure 7-1: Web Options Configuration in stand-alone system 
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ES/OS Master as OS Web server 
To control and monitor the system process, the OS web clients retrieve 
their project data using the Internet Explorer of the OS web server via the 
Intranet/Internet. 

Furthermore, the system process has a redundant design to offer the plant 
operation the greatest possible failure protection (this is not the case for the 
web option!) 

 
Figure 7-2: Web Options Configuration in redundant stand-alone system 

 
 



 
Expansion by PCS 7 Web Option

Minimal Configurations PCS 7 V7.1 24023824
 

Version 3.3 13.09.2011 98/118
 

C
op

yr
ig

ht
 ©

 S
ie

m
en

s 
A

G
 2

01
1 

A
ll 

rig
ht

s 
re

se
rv

ed
 

7.2 Web-Specific Hardware and Software Requirements 

Hardware components 
Table 7-1 OS Web Server 

Component Requirement 

Minimum hardware (PC) 
requirement 

Intel Pentium IV, 2.8 GHz, 1 GB work 
memory 

Recommended hardware 
(PC) requirement 

Intel Pentium IV, 3.4 GHz, 1 GB work 
memory 

Miscellaneous Fast access (>= 64 kbit/s) to web client via 
Internet/Intranet or TCP/IP connection 

 
Table 7-2 OS Web Client 

Component Requirement 

Minimum hardware (PC) 
requirement 

No PDAs, tablet PCs etc. 

Miscellaneous Fast access (>= 64 kbit/s) via  TCP/IP 
connection 

 

Software components 
Table 7-3 OS Web Server 

Component Requirement 

Operating system Windows XP Professional  
(or also Windows Server 2003) 

Software Internet Explorer 
Internet Information Services (IIS) 

License SIMATIC PCS 7, Software Web Server V 
(3 Clients) Single License 

 
Table 7-4 OS Web Client 

Component Requirement 

Operating system Windows XP Professional  
(or also Windows Server 2003) 

Software Internet Explorer 
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Note The Internet Explorer version is adequate to choose for the PCS 7 
version, after the following FAQ: 

http://support.automation.siemens.com/WW/view/en/2334224 

Further information regarding hardware and software requirements can 
be found in document: 
“Process Control System PCS 7 > PCS 7 Readme” 

 
 

 

7.3 Installation of OS Web Server 

Content 
Below you find a description, how to install a web server on an ES/OS 
stand-alone system. 

 

Requirements 
• The hardware and software requirements mentioned in chapter 7.2 are 

fulfilled. 

• The Internet Information Services (IIS) has to be enabled before you 
can start installing the "PCS 7 Web Server" software. 
“Start > Settings > Control Panel > Add or Remove 
Programs > Add/Remove Windows Components > Internet 
Information Services” 

 

Installation of Software 
Table 7-5 

Step Action Note 
1.  Select the "Setup.exe" file from the 

PCS 7 tool set DVD and open it by 
double-clicking it or via the context 
menu. 
 
Setup will start. 

 

http://support.automation.siemens.com/WW/view/en/2334224�
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Step Action Note 
2.  Follow the setup instructions. 

Select the option "Install" when 
selecting the "Setup type". 
Subsequently click "Next". 

 
3.  Enable the option "Package 

installation". 
Click the "Next" button. 

 
4.  The "Program packages" dialog field 

is opened. 
From the options select "PCS 7 Web 
Server". 
Click the "Next" button. 

 
5.  In the subsequent dialog field, the 

PCS 7 options already installed and 
the newly selected "Program 
packages" are displayed. 
Click the "Next" button. 
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Step Action Note 
6.  Before installation starts the "Program 

packages" you want to install new, are 
listed separately. 
Check your selection and click the 
"Install" button when the desired PCS 
7 options are displayed. 

 
 

7.4 Configuration of OS Web Server 

 

Configuration steps on the ES 
• Publishing of pictures by means of Web View Publisher 

• Configuring user rights, start screen and language of website in user 
administrator 

• Loading and compiling of Web Server 

 

Publishing of OS data 
Pictures and scripts which are supposed to run on the web clients later are 
published on the OS Web Server using the Web Publisher. Doing this, the 
following actions are carried out: 

• Project data is compressed and stored 

• Screen windows are transferred into web-enabled ActiveX components 

• Scripts are converted so that they can be run on the Web 

 

Requirements 
To be able to publish the Web server data the following prerequisites have 
to be fulfilled: 

• PCS 7 project is readily configured 

• OS has already been compiled 

• Scripts which the Web clients access are available 

• Process pictures do not have a double underscore (e.g. yy__xx.pdl) 

• Variable name in plain text (inverted commas) in C scripts contain no 
spaces 
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Note For a stand-alone system only one publishing process for the publishing 
of local data on the Web server is necessary. 

Information regarding the issue of "Supported script normal functions" 
can be found in the manual: 
“SIMATIC Process Control System PCS 7 OS Web Option > 
Configuration of the OS Web server on an ES > Changes 
to project data > Web-Executable Functions for PCS 7 
OS Web Option“ 

 
 

7.4.1 Publishing of Project Data 

Table 7-6 

Step Action Note 
1.  Open the OS project of the OS Web 

Server in WinCC Explorer. 
Select the command "Web View 
Publisher" via the context menu of 
the "Web Navigator" editor. 
The "WinCC Web Publishing Wizard 
– Introduction" dialog field opens up. 
Click the "Next" button. 

 
2.  The "WinCC Web Publishing Wizard 

– Select directories" dialog field 
opens up. 
Disable the option "Server Prefix" 
since you want to publish local data. 
Accept the preset target and source 
path. If you would like to change the 
respective path, click the button 
behind the shaded input fields. 
Navigate to the desired target or 
source file. 
Click the "Next" button. 
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Step Action Note 
3.  The "WinCC Web Publishing Wizard 

– Select pictures" dialog field opens 
up. 
Select all pictures you want to 
publish. We generally recommend to 
publish all standard pictures. 
Via the ">>", "<<", ">" and "<" 
buttons you can select the pictures. 
Click the "Next" button. 

 
4.  The "WinCC Web Publishing Wizard 

– Select functions" dialog field opens 
up. 
Select all functions you want to 
publish. Only the scripts which were 
selected in the last publishing 
process are available in the pictures. 
This is why you select all necessary 
function for each publishing process. 
Via the ">>", "<<", ">" and "<" 
buttons you can select the functions. 
Click the "Next" button. 

 

5.  The "WinCC Web Publishing Wizard 
– Referenced Graphics" dialog field 
opens up. 
Select all graphics you want to 
publish. We generally recommend to 
publish all graphics. 
Via the ">>", "<<", ">" and "<" 
buttons you can select the graphics. 
Click the "Next" button. 

 
6.  The "WinCC Web Publishing Wizard 

– Finish" dialog field opens up. 
Click the "Finish" button. 
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Step Action Note 

 
7.  Pictures and functions which contain 

faulty scripts are marked with a red 
cross. 
Double-click each faulty picture to 
open and correct the picture in the 
"PdlPad" editor. 
Confirm the message after each 
publishing process by clicking the 
"OK" button. 

 
8.  The transferred pictures are listed in 

the "WinCC Web Publishing Wizard 
– Finish" dialog field. 
Click the "Finish" button. 

 
9.  The published pictures are displayed 

in the data window of the Web 
Navigator. 
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7.4.2 Setting of User Rights, Website Start Screen and Language 

Access restriction 
Accesses of the Web Clients on the OS Web Server are controlled via user 
rights. User rights are assigned in the "User Administrator" editor. The user 
rights correspond to those of the standard clients. 

 

Settings in the "User Administrator" Editor 
Table 7-7 

Step Action Note 

1.  Open the "User administration" in the 
opened OS project of the WinCC 
Explorer. 
Create new users and/or new user 
groups and assign them respective 
authorizations. 
In addition, enable the option 
"WebNavigator" for the user/user 
group and enter the "Start Picture" 
and "Language" in the respective 
input fields. 

 

2.  Select the start picture from the 
published graphics via the "…" 
button. 
“…\OS Web Server\<wincc 
project release name>\Web 
Navigator\pictures” 
Select the "@screen.pd_" graphic as 
start picture. 
Confirm your selection with the 
"Open" button. 
This is also how you determine a 
language for the control and 
monitor interface of the Web clients. 
To do this, click the respective "…" 
button. 
Confirm your selection with the "OK" 
button. 

3.  Close the User Administration editor.  
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7.4.3 Configuring with the Web Configurator 

Tasks of the Web Configurator 
The Web configurator sets up and manages the Internet Information 
Service (IIS) and therefore the website of the OS web server. This setup is 
carried out on the web server after you have loaded the project on the web 
server. This setup and configuration is necessary to set up an operator 
station (OS) as OS web server and to make it accessible for web clients via 
the Intranet/Internet. 

With the Web Configurator you can make the necessary firewall settings for 
the network card, if the firewall is enabled. 

Requirements of the stand-alone system 
• PCS 7 Web Server software is installed on the stand-alone system 

• the OS project is loaded on the stand-alone system 

• settings in the OS are completed 

• pictures, functions and graphics have been published 

• user rights have been assigned/created 

 

Note Further information regarding the setup of a standard website can be 
found in the manual: 
“SIMATIC Process Control System PCS 7 OS Web Option > 
Completing configuration on the OS Web server” 

 
 

Settings in the "Web Navigator" editor 
Table 7-8 

Step Action Note 
1.  Open the OS project on the OS Web 

Server in the WinCC Explorer. 
Select the command "Web 
Configurator" via the context menu 
of the "Web Navigator" editor. 
The "WinCC Web Configurator" 
dialog field opens up. 
Click the "Next" button. 
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Step Action Note 
2.  In the next window select the option 

"Create a new standard Web site 
(stand-alone)". 
Click the "Next" button. 

 
3.  Specify a name for your Web site in 

the "Name of Web site" input field. 
Also assign the IP address and the 
connection port of the computer via 
the "Port" and "IP Address" input 
fields. 
Select "MainControl" from the drop-
down list of the "Default Web-Page" 
input field. 
Also enter a time in the "Reconnect 
Interval" input field 
Enable the option "Start the web-site 
after being configured". 
Click the "Next" button. 

 

4.  If the Windows-Firewall is not 
enabled, continue with step 8. 
Otherwise click the "Windows-
Firewall" button (the button is only 
visible when the Firewall is enabled). 

 



 
Expansion by PCS 7 Web Option

Minimal Configurations PCS 7 V7.1 24023824
 

Version 3.3 13.09.2011 108/118
 

C
op

yr
ig

ht
 ©

 S
ie

m
en

s 
A

G
 2

01
1 

A
ll 

rig
ht

s 
re

se
rv

ed
 

Step Action Note 
5.  In the "Windows-Firewall" dialog field 

select the "Advanced" tab. 

 
6.  Enable the optional box for the 

desired network connection. 
Click the "Settings..." button. 
The "Advanced Settings" dialog field 
is opened. 

 
7.  This is where you enable the 

optional box "Secure Web Server" 
and/or "Web Server".  
Click the respective "OK" button. 
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Step Action Note 
8.  Click the "Finish" button. 

 
9.  Click the "OK" button. 

Afterwards close the WinCC 
Explorer and restart your computer 
to accept all settings.  

 

 

 

7.4.4 Loading and Compiling of Web Server 

Loading of Web Server 
Since the OS Web Server is a stand-alone system (ES/OS/Web Server), a 
loading and/or delta download of project data is not necessary because 
local data is already present through "Compile OS". 

Compiling 
The "Compile changes" function can be carried out for stand-alone systems 
without having to interrupt the process operation of the Web server. 

 

Note Further information regarding the configuration of the OS Web Server can 
be found in the manual: 
“SIMATIC Process Control System PCS 7 OS Web Option > 
Configuration of the OS Web server on an ES” 
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7.5 Settings on Web Client 

 

Settings of web content zone "Internet" or "Local Intranet" 
You have to make or check the settings for the web content page in the 
Internet Explorer to be able to install the plug-ins for the Web Client of the 
OS Web Server later. 

Table 7-9 

Step Action Note 
1.  Open the Internet Explorer. 

Select the command “Tools > 
Internet Options” 

 
2.  Click the "Security" tab. 

Select the web content zone in which 
the Web server is located ("Internet" 
or "Local intranet"). 
Click the "Custom level..." button. 
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Step Action Note 
3.  Enable the option under "Execute 

ActiveX controls safe for scripting" 
and "Download signed ActiveX 
controls" 

 
4.  Click the respective "OK" buttons for 

the dialog fields "Security Settings" 
and "Internet Options" to close them. 
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Settings of web content zone "Trusted sites" 
Table 7-10 

Step Action Note 
1.  Open the Internet Explorer. 

Select the command “Tools > 
Internet Options”. 

 
2.  Click the "Security" tab. 

Select the web content zone 
"Trusted sites". 
Click "Sites" to open the dialog field. 

 
3.  Enter the address of the OS Web 

Server in the "Add this website to the 
zone" input field 
e.g. *://172.33.3.7 or 
http://*.microsoft.com 
Additionally, disable the option 
"Require server verification (https:) 
for all sites in zone". 
Click the "Add" and "Close" buttons. 
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Step Action Note 
4.  Select the web content zone 

"Trusted sites". 
Click the "Default level" and 
afterwards the "Custom level…" 
button. 

 
5.  Enable the option "Initialize and 

script ActiveX controls not marked as 
safe for scripting" in the dialog field 
"Security Settings". 

 
6.  Click the respective "OK" buttons for 

the dialog fields "Security Settings" 
and "Internet Options" to close them. 

 

 

Therefore the requirements for a connection of Web client to Web server 
have been created. 
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7.6 Installation of Web Client Plugins 

Installation paths 
When installing the plugins for the Internet Explorer you can choose 
between two installation paths: 

• Remote installation – installation via the Intranet/Internet of the Web 
server 

• Local installation – installation via the Windows Installer Package of the 
Web Client 

In application example we look at the "Remote installation". 

Requirements 
• the OS Web Server is in runtime. 

• the web client has access to the web server 

• you know the web server address 

• you know the domain, user name and password 

• the user authorizations are valid for PCS 7 Web Options 

• the login on the PC has the rights of a main user. 

Installation 
Table 7-11 

Step Action Note 
1.  Open the Internet Explorer. 

Enter the Web Server address 
(http://<Server name or IP>) in the 
"Address" input field. 
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Step Action Note 
2.  Enter the access data in the 

"Connect to <severname>" dialog 
field which was determined on the 
Web server in the "User 
Administrator" editor. 

 
3.  During the first connection the 

"Security Warning" dialog field will 
open up. 
Continue by clicking the "Install" 
button. 

 
4.  A note will appear in the main 

window, saying that the "Web 
Navigator Client“ software has to be 
installed first. 
Click on the bottom link "Click here 
to install" to start installation. 

 
5.  The InstallShield Wizard is started. 

Click the "Next" button to install the 
"WebNavigator Client" software 
Follow the instructions of the wizard. 
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Step Action Note 
6.  Select the option "Complete" in the 

dialog field "Setup Type". 
Click the "Next" button. 

 
7.  Click the "Install" button to trigger the 

installation process of the 
"WebNavigator Client" software. 

 
8.  To complete the installation, click the 

"Finish" button in the last step of the 
wizard. 

 
9.  In the main window you can now see 

which components have been 
successfully installed on the web 
client. 
Before you click on the reference 
"Process pictures", install the 
necessary plugins first, to be able to 
operate and monitor the process 
accordingly.  
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Step Action Note 
10.  Move the cursor to the left edge of 

the screen of the Internet Explorer 
window to make the navigation bar 
visible there. 
Click on the "double arrow" icon in 
the navigation menu next to the 
name or the IP address of the web 
server. 
Click the sub-menu "Download 
Area". 
This is where you select "Download 
plugins". 

 

11.  Now all available plugins for the web 
client will be displayed in the Internet 
Explorer window. 
In the "Install" column, click the 
arrow before the version number to 
install the plugin. 

 
12.  The plugins: 

WinCC Basic Process Control 
WinCC Basic Process Control 
PCS 7 Faceplates 
PCS 7 Advanced Faceplates 
should be installed to guarantee 
minimum process control. 
During installation the displayed 
sequence is to be observed. 
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Step Action Note 
13.  Installation of the web client is 

complete. 
Close the Internet Explorer and 
reopen it to register for process 
control. 
As soon as the web client has 
established a connection with the 
web server, the process pictures can 
be called. 

 

Note Further information regarding the installation of the web client, process 
control on the web client and settings can be found in the manual: 
“SIMATIC Process Control System PCS 7 OS Web Option > 
Installation and Settings for the Web Client” 
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